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Customer support

You can obtain technical support by using the BMC Software Customer Support website or by contacting Customer 
Support by telephone or e-mail. To expedite your inquiry, see “Before contacting BMC.”

Support website

You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support. From this 
website, you can

■ read overviews about support services and programs that BMC offers
■ find the most current information about BMC products
■ search a database for issues similar to yours and possible solutions
■ order or download product documentation
■ download products and maintenance
■ report an issue or ask a question
■ subscribe to receive proactive e-mail alerts when new product notices are released
■ find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and 

telephone numbers 

Support by telephone or e-mail

In the United States and Canada, if you need technical support and do not have access to the web, call 800 537 1813 or 
send an e-mail message to customer_support@bmc.com. (In the subject line, enter SupID:<yourSupportContractID>, 
such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC

Have the following information available so that Customer Support can begin working on your issue immediately:

■ product information

— product name
— product version (release number)
— license number and password (trial or permanent)

■ operating system and environment information

— machine type
— operating system type, version, and service pack or other maintenance level such as PUT or PTF
— system hardware configuration
— serial numbers
— related software (database, application, and communication) including type, version, and service pack or 

maintenance level

■ sequence of events leading to the issue

■ commands and options that you used

■ messages received (and the time and date that you received them)

— product error messages
— messages from the operating system, such as file system full
— messages from related software 

http://www.bmc.com/support
mailto:customer_support@bmc.com
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C h a p t e r 1

1  Product components and capabilities

This chapter provides a brief overview of the PATROL for JBoss Application Server 
product. The chapter contains the following sections:

PATROL for JBoss Application Server features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Product architecture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Application class hierarchy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12
JBoss data collection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Application classes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Application instance naming conventions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Accessing product Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Additional information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Where to go from here. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

PATROL for JBoss Application Server features
The PATROL for JBoss Application Server product provides a monitoring capability 
for reliable, predictable performance of a JBoss Application Server environment.

PATROL for JBoss Application Server enables you to 

■ monitor runtime application server availability
■ monitor availability and performance of JBoss resources, such as thread pools, 

overall memory utilization, and web services
■ monitor performance of servlets, Oracle® JavaServer Pages (JSPs), and Enterprise 

Java Beans (EJBs) 
Chapter 1 Product components and capabilities 11



Product architecture
Depending on the collection categories that you choose to discover, the product can 
provide you with information about the following categories:

■ Enterprise JavaBean (EJB)
■ Java EE Connector Architecture (JCA)
■ Java Message Service (JMS)
■ Java Transaction API (JTA)
■ Java Virtual Machine (JVM)
■ Java Servlet/JavaServer Pages (SERVLET/JSP)
■ Collection thread metrics (THREAD)
■ Web Application Archive (WAR)

Product architecture
This section contains information about the hierarchy of information displayed on the 
PATROL Console and about the general architecture of PATROL for JBoss 
Application Server.

Application class hierarchy

Figure 1 shows the organization of application classes in PATROL for JBoss 
Application Server. Most application classes that represent JBoss objects can have 
multiple instances and are organized into groups called containers. 

Information about how these instances are named is on page 17. For more 
information about each application class, see “Application classes” on page 15. 
12 PATROL for JBoss Application Server User Guide



Product architecture
Figure 1 Application class hierarchy in PATROL for JBoss Application Server
Chapter 1 Product components and capabilities 13



Product architecture
JBoss data collection

Figure 2 shows how the PATROL Console interacts with the PATROL Agent on a 
JBoss Application Server. A Java client collects performance data from the application 
server through an RMI connection. PATROL obtains the performance data from the 
JBoss administration server or the application server through API calls. The PATROL 
Agent periodically collects these metrics by using a Java client, and then passes 
information to the PATROL Console or PATROL Console Server. 

Figure 2 Architecture of PATROL for JBoss Application Server

The following sections describe the components shwon in Figure 2:

PATROL Consoles, PATROL Console Servers

PATROL Consoles and PATROL Consoles Servers provide the ability to interact with 
one or more PATROL agents to set up and configure PATROL for JBoss Application 
Server, and to manage JBoss. You must install PATROL for JBoss Application Server 
on at least one PATROL Console for Windows or UNIX®, or on a PATROL Console 
Server that provides PATROL common services. Installing on a console server allows 
you to use PATROL Central for Windows or PATROL Central for Web as your 
console.

PATROL Agent

An Agent can be used to monitor multiple JBoss servers or multiple base application 
servers throughout your network. 

PATROL Consoles

• PATROL for JBoss

Host with

JBoss servers

• Other PATROL KM

PATROL Console
Servers

Application Server

products

JBoss Application Server

• PATROL Agent

• PATROL for 

PATROL

• Other PATROL 

JBoss
Application
Server

KM products

components

Java 
Clients
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Application classes
JBoss Servers

These are the application servers that are monitored.

Java clients

BMC provides clients that interact with various JBoss components and external 
components to gather information such as performance statistics, process status, and 
resource availability. These clients are designed to be launched once and reused 
through PSL global channels for maximum efficiency.

Application classes
PATROL for JBoss Application Server contains several applications and application 
containers. Application containers group together multiple instances of a managed 
resource. 

The PJB_MAIN application container represents the JBoss Application Server 
environment, and might contain a single server or multiple servers. It is labeled JBoss.

The JBossSetup icon and the JBoss icon are displayed in the computer window along 
with various other product icons, if any.

Figure 3 PATROL Console 

setup icon for PATROL for JBoss Application Server
Chapter 1 Product components and capabilities 15



Application classes
Table 1 describes the PATROL for JBoss Application Server application classes

Table 1 Application Classes and functions  (Part 1 of 2)

Application class name Description

PJB_MAIN is the main application class for all JBoss instances. 

PJB_SETUP is the main application class for all JBoss environments. 

PJB_CLUSTER contains an instance of a JBoss cluster.

PJB_CLUSTERED_SERVER contains instances of a JBoss Application Server in a 
cluster.

PJB_CONNECTION_THREAD_POOL contains connection thread pool parameters.

PJB_EJB_CONTAINER contains Enterprise JavaBean (EJB) instance parameters. 

PJB_EJB2 contains Enterprise JavaBean 2 (EJB2) parameters. 

PJB_EJB3 contains Enterprise JavaBean 3 (EJB3) parameters. 

PJB_ENVIRONMENT contains parameters for registered JBoss environments.

PJB_GARBAGE_COLLECTION_
CONTAINER

contains Garbage Collection instance parameters.

PJB_GARBAGE_COLLECTION contains Garbage Collection parameters.

PJB_JCA_CONTAINER contains Java EE Connector Architecture (JCA) instance 
parameters.

PJB_JCA contains JCA parameters.

PJB_JCA_V4 contains JCA v4 parameters.

PJB_JMS_CONTAINER contains Java Message Service (JMS) instance parameters.

PJB_JMS_QUEUE contains JMS Queue parameters.

PJB_JMS_QUEUE_V4 contains JMS Queue v4 parameters.

PJB_JMS_QUEUE_V5 contains JMS Queue v5 parameters.

PJB_JMS_TOPIC contains JMS Topic parameters.

PJB_JSP_CONTAINER contains JavaServer Page (JSP) instance parameters. 

PJB_JSP contains JavaServer Page (JSP) parameters. 

PJB_JTA contains Java Transaction API (JTA) parameters.

PJB_JVM contains Java Virtual Machine (JVM) parameters.

PJB_JVM_CLASSLOADING contains JVM classloading parameters.

PJB_JVM_OS contains JVM operating system parameters.

PJB_JVM_THREAD contains JVM thread parameters.

PJB_MEMORY_POOL_CONTAINER contains Memory Pool instance parameters.

PJB_MEMORY_POOL contains Memory Pool parameters.

PJB_QUEUE_THREAD_POOL contains queue thread pool parameters.

PJB_QUEUELESS_THREAD_POOL contains queueless thread pool parameters.

PJB_REGISTERED_ENVIRONMENT contains parameters for registered JBoss environments.

PJB_SERVER is the main application class for standalone servers.
16 PATROL for JBoss Application Server User Guide



Application classes
Application instance naming conventions

Many application classes in PATROL for JBoss Application Server can have multiple 
instances, each with a unique name. The name is used to label icons in the PATROL 
Console. Application class instances are named using the conventions shown in 
Table 2. 

PJB_SERVLET_CONTAINER contains Java Servlet instance parameters.

PJB_SERVLET contains Java Servlet parameters.

PJB_THREAD_POOL_CONTAINER contains thread pool instance parameters.

PJB_WAR_CONTAINER contains Web Application Archive (WAR) instance 
parameters.

PJB_WAR contains WAR parameters.

Table 2 Instance naming conventions  (Part 1 of 2)

Application
Instance naming convention 
(discovered from JBoss Server) Example

PJB_CLUSTER Name of a server cluster DefaultPartition(env1)

PJB_CLUSTERED_
SERVER

Name of a server in a cluster 10.64.50.45:1099

PJB_CONNECTION_
THREAD_POOL

Name of a Connection Thread http-10.64.50.45-8009

PJB_EJB2 Name of an EJB2 SecureManagementView

PJB_EJB3 Name of an EJB3 SecureDeploymentManager

PJB_ENVIRONMENT Name of the environment that you 
specified

env1

PJB_GARBAGE_
COLLECTION

Name of the garbage collector Copy

PJB_JCA Name of a JCA instance DefaultDS

PJB_JMS_QUEUE Name of a JMS Queue DLQ

PJB_JMS_TOPIC Name of a JMS Topic DLQ

PJB_JSP Name of a JSP jsp

PJB_JTA Name of a JTA Transaction Manager

PJB_JVM Name of a JVM JVM Resources

PJB_JVM_
CLASSLOADING

Name of a JVM Class Loader Class Loading

PJB_JVM_OS Name of the JVM’s operating system Operating System

Table 1 Application Classes and functions  (Part 2 of 2)

Application class name Description
Chapter 1 Product components and capabilities 17



Accessing product Help
Accessing product Help
PATROL for JBoss Application Server provides Help topics for the currently 
displayed window or dialog box. You can also start the Help system for the KM, and 
get help for application classes and parameters.

How you get the product Help depends on the type of PATROL Console you are 
using. For specific instructions about accessing Help in each Console type, refer to 
“Accessing online Help” on page 60 in Appendix A, “Accessing menu commands, 
InfoBoxes, and online Help.”

Additional information
A core set of PATROL manuals is provided on the documentation CD included with 
major releases of the PATROL Console and Agent. You can also view manuals in 
electronic format or order additional printed copies from the Web: 
http://www.bmc.com/support_home.

For the latest updates to product information, refer to the release notes, which are 
also available at http://www.bmc.com/support_home.

PJB_JVM_THREAD Name of a JVM Thread Threading

PJB_MEMORY_POOL Name of a Memory Pool Code Cache

PJB_QUEUE_THREAD_P
OOL

Name of a Queue Thread Pool WorkManagerThreadPool

PJB_QUEUELESS_
THREAD_POOL

Name of a Queueless Thread Pool LongRunningTasksThreadPool

PJB_REGISTERED_
ENVIRONMENT

Name of the environment that you 
specified

env1

PJB_SERVER Name of a standalone server 10.64.50.45:1099

PJB_SERVLET Name of a Java Servlet Status Servlet

PJB_WAR Name of a WAR admin-console

Table 2 Instance naming conventions  (Part 2 of 2)

Application
Instance naming convention 
(discovered from JBoss Server) Example
18 PATROL for JBoss Application Server User Guide
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Where to go from here
Where to go from here
If you are ready to install and configure the PATROL for JBoss Application Server 
product, see Chapter 2, “Installing PATROL for JBoss Application Server.”
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Installation requirements
Before installing PATROL for JBoss Application Server, verify that:

■ your system is supported for this product

■ you have a valid license from BMC Software and an appropriate account from 
which to install the product

■ your Java environment is supported for this product

Operating system and JBoss support

Before installing PATROL for JBoss Application Server, verify that the target 
computer meets the installation requirements listed in the release notes for version 
1.0.00 of the PATROL for JBoss Application Server product.

Virtual machine support limitation

VMWare provides technology that creates virtual infrastructures by providing a layer 
of abstraction between the computing, storage, and networking hardware, and the 
software that runs on it. This technology enables customers to run additional 
operating systems in multiple windows called virtual machines (VMs).

BMC does not anticipate problems with the PATROL and SmartDBA product 
families in virtual infrastructure implementations, but products within these families 
have not been specifically tested. Therefore, BMC only provides support for problems 
that are reproducible without these complementary technologies. 

Performance and scalability

BMC tested PATROL for JBoss Application Server to assess its performance in typical 
JBoss Application Server environments in different configurations. Generally, BMC 
found that:

NOTE  
Any information for UNIX, unless otherwise specified, applies to any supported 
versions of Linux®.
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■ In a basic out-of-the-box configuration, monitoring an active JBoss Application 
Server environment, PATROL for JBoss Application Server uses negligible 
resources.

License

Verify that you have a a permanent license to run your PATROL product or a valid 
demonstration license. If you have not yet installed a permanent license, contact your 
BMC sales representative or the BMC Contract Administration department for 
licensing information.

Installation account

Install PATROL for JBoss Application Server on each machine by using the dedicated 
PATROL OS account under which you installed the PATROL Console or Agent. 

If you do not already have a dedicated PATROL account, this section describes how 
to set up a PATROL installation account for Microsoft Windows and UNIX platforms. 

Windows environments

In a Windows environment, PATROL requires a dedicated user account that is 
known as the PATROL default account. The PATROL default account must be 
created before you install PATROL. The PATROL default account can be either a local 
or a domain account.

Standalone workgroup servers must use a local user account as a PATROL default 
account. Servers that are trusted members of a domain might use either a local or 
domain account. In each case, the PATROL default account must be a member of the 
local administrators group of the computer where the agent will reside.

PATROL default accounts on domain controllers should be only domain accounts. 
The account on a domain controller must be a member of the domain administrators 
group.

Although you can use an existing Windows user account, BMC recommends that you 
create a separate Windows user account for PATROL.

WARNING  
Do not use a domain or local Administrator account as the PATROL default account. 
Such account usage causes files that are created by PATROL to be owned by the 
Administrator, which could result in security or file access problems.
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UNIX environments

BMC Software recommends that the UNIX account that you create meet the 
following conditions:

■ The account .login, .profile, .cshrc, and .kshrc files should contain as little user 
customization as possible. Specifically, there should be no aliases, the prompt 
should be set to the default, and there should be no commands in these files that 
change the umask setting. The recommended umask setting for the installation 
account is 022.

■ Do not use root to install PATROL products because this might create security 
risks.

■ Be sure the account has permission to create directories in the directory where you 
will install PATROL products.

The account that you use to install PATROL must have permission to write the 
installation logs to the $HOME and /tmp directories on the computer where you are 
installing products.

Preparing to install
BMC recommends that you install the product on a limited number of development 
or test machines first, then configure and test the product before installing into a 
production machine environment.

Installation prerequisites

Before you install, you must

■ ensure you are using the appropriate version of the installation utility (see page 25)
■ understand target machines and their roles (see page 25)
■ understand PATROL security options (see page 28)

Checking for product patches or fixes before installing

Product fixes or patches are often available through the BMC Software Web site. 
Patches correct problems that are found after a product is released. BMC 
recommends that you check the product page for the current version of PATROL for 
JBoss Application Server on the BMC Customer Support Web page to determine 
whether a patch is available before you begin installing a product.
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Remote installation

If you create an installable image, the product configuration information that you 
enter, such as the BMC products installation directory, account names, passwords, 
PATROL Agent port number, and security options, must be the same for all 
computers on which the image is to be installed. If you want to specify different 
settings for different computers, you must either create a separate image for each set 
of values that you want to implement, or edit the variables in the image control file by 
using the ctltool command.

For more information about creating, distributing, and installing installable images, 
and about using ctltool utility, see the PATROL Installation Reference Manual.

Determine the version of the installation utility

For best results, perform the installation procedure using a recent version of the 
PATROL installation utility, version 7.5.62 or later. 

To determine the version of the installation utility

1 Open a command prompt.

2 Navigate to the directory where the installation utility is located.

3 Enter one of the following commands:

■ Windows: setup.exe -v 
■ UNIX: setup.sh -v 

A message box displays the version of the installation utility.

Target computers and their roles

The installation utility prompts you to select the roles that are performed by the 
computer on which you are installing BMC products (the target computer). Before 
beginning the installation process, review the following definitions of the roles that 
are presented in the installation utility and decide which of these roles applies to each 
computer in your environment. 

Roles performed by computers in the PATROL architecture

The roles performed by computers in the PATROL architecture are
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■ Console Systems (also referred to as console computers) host user desktop 
applications such as consoles, user interfaces, viewers, and browsers. Select this 
option if the computer to which you are installing will perform any of the 
following tasks:

— monitor and manage on Windows by using a PATROL Central Operator – 
Microsoft Windows Edition console (PATROL 7.x architecture) 

— monitor, manage, and develop KMs on UNIX by using a PATROL Console for 
UNIX (PATROL 3.x architecture)

— monitor, manage, and develop KMs on Windows by using a PATROL Console 
for Windows (PATROL 3.x architecture)

■ Managed Systems (also referred to as agent computers) host software that manages 
the resources on the computer, such as a PATROL Agent, PATROL Knowledge 
Modules, and Service Reporting Retrievers. Select this option if the computer to 
which you are installing will perform any of the following roles:

— host a PATROL Agent 3.6.50 (works with both the PATROL 3.x and PATROL 
7.x architecture)

— host KMs and components that contain the knowledge that PATROL uses to 
monitor the resources on this computer

— A Common Services (PATROL 7.x architecture) computer hosts services that are 
shared among managed systems and console systems. You can install each of 
these common services on any computer in the network. Select this option if the 
computer to which you are installing will perform any of the following roles:

— host the PATROL Central Operator – Web Edition (PATROL 7.x architecture) 
Web server

— host the PATROL Console Servers

— host the RTservers

For more information about the PATROL consoles and PATROL Console Server or 
RTserver, see the respective online Help systems and the following documents:

■ PATROL Central Operator - Web Edition Getting Started

■ PATROL Central Operator - Microsoft Windows Edition Getting Started

■ PATROL Console Server and RTserver Getting Started

■ PATROL Configuration Manager User Guide
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■ PATROL Console for Microsoft Windows User Guide - Understanding the Basics of 
PATROL, Volume 1

■ PATROL Console for UNIX User Guide

Determining where to install KMs based on architecture

PATROL 3.x and PATROL 7.x architectures differ as to which target computers store 
KMs and how much KM information is required by each type of system. During 
installation, ensure that you select the appropriate types of systems according to the 
following information:

PATROL 3.x

Install KM packages to Managed Systems and Console Systems. 

A PATROL 3.x environment includes the following components:

■ PATROL Agent 3.8.00 or later runs on Managed Systems.
■ PATROL Console for Windows or PATROL Console for UNIX 3.6.50 runs on 

Console Systems.

PATROL 7.x

For PATROL Central Operator – Microsoft Windows Edition, install KM packages to 
Console Systems, Common Services Systems, and Managed Systems. 

For PATROL Central Operator – Web Edition, install KM packages to Common 
Services Systems and Managed Systems.

A PATROL 7.x environment includes the following components:

■ PATROL Agent 3.8.00 runs on Managed Systems.
■ RTserver runs on Commons Services Systems.
■ PATROL Console Server runs on Common Services Systems.
■ PATROL Central Operator – Microsoft Windows Edition, PATROL Central 

Operator – Web Edition, or both run on Console Systems.

For more information about the PATROL 7.x architecture, see the PATROL 
Infrastructure Planning Guide.

Mixed PATROL 3.x and 7.x environment

A mixed PATROL 3.x and 7.x environment includes the components from both a 
PATROL 3.x environment and a PATROL 7.x environment.
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Typical and custom installation Types

The installation utility prompts you to select one of the following installation types: 

■ Typical- In general, use the Typical installation type if you are installing PATROL 
for JBoss Application Server for the first time or if you are upgrading from a 
previous installation and you want to use standard default settings for directories 
and port numbers.

■ Custom- In general, use the Custom installation type if you want to install only 
individual components, or if you are upgrading from a previous version of a 
PATROL KM and have a PATROL environment that might be configured with 
non-standard settings.

PATROL security

By implementing PATROL security, you can protect the data that is passed between 
PATROL components and restrict unauthorized users from accessing your data. 
PATROL security is installed as part of the agent, console server, and consoles. KMs 
inherit the security policy from the agent, console server, and console on which the 
KMs are installed. 

For more information about implementing and using PATROL security, see the 
following documentation:

■ PATROL Security User Guide
■ PATROL Security Release Notes

NOTE  
If you are installing PATROL for JBoss Application Server to an existing PATROL Agent or 
Console environment that is not in the default installation directory, use Custom. Do not use 
Typical. Typical automatically installs the agent or console with PATROL for JBoss 
Application Server, and your existing installation is overwritten. If you do not want to 
overwrite your existing installation, use Custom so that you can clear the selection of the 
agent or console product component.
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Default login shell

If you are installing into a UNIX environment, BMC recommends that you define the 
default login shell when you prepare to install. Although setting a default login shell 
is not specifically a requirement for installation, starting the KM without having 
defined the correct login shell might result in unpredictable behavior.

Both the JBoss Administration Account and the PATROL Default User Account must 
be set to use one of the following the default login shells:

■ the Bourne shell (sh)
■ the Korn shell (ksh)

Mounting a CD on UNIX

The following sections provide information about the mount commands that are used 
for mounting the PATROL product CDs on your UNIX system. 

Mounting the CD

In this procedure, the root directory for the CD drive is called /cdrom. This directory 
might be different for your computer, depending on how your system administrator 
has configured the device. If a problem occurs, consult your system administrator or 
read the man page for the mount.

1 Log on as root. 

2 Insert the CD into the CD drive. 

3 Use the mount command that applies to your platform to mount the CD.

4 Log off.

Table 3 Mount commands by platform

Platform Mount Command

IBM® AIX® mount -r -v cdrfs /dev/cd0 /cdrom

HP-UX mount -F cdfs -o ro /dev/dsk/drive_for_cdrom/cdrom

Linux mount /dev/cdrom /path_to_target_mount_point

Oracle® Solaris Volume Manager (/usr/sbin/vold) automatically mounts. 
Otherwise, mount -r -F hsfs /dev/sr0 /cdrom
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Mounting the CD drive for an NFS Client

Before you can mount the CD on a Network File System (NFS) device, you must 
export the CD file system so that the CD can be mounted by NFS clients. 

Most platforms use the exportfs command to export a local file system, including a CD 
file system. However, Solaris platforms use the share command.

To mount the CD on an NFS client, follow these steps:

1 Log on as root. 

2 Create a directory on your local computer as the mount point for the CD on the 
remote host computer (for example, /mnt/cdrom or /mnt/cdrom/cdrom0 for Solaris).

3 Use the mount command that applies to your platform to mount the CD.

If a problem occurs, consult your system administrator or read the man page for 
the mount. 

4 Log off.

Installing PATROL for JBoss Application Server
This section describes how to perform a new installation of PATROL for JBoss 
Application Server. You can optionally perform remote or multiple installations by 
using the Distribution Server (see “Distribution Server” on page 33).

You should first install on a limited number of machines in a test environment, then 
test the installation thoroughly, and then install in your production environment. 

Table 4 NFS mount commands by platform

Platform Mount Command

AIX, HPUX-PA1.0 mount host:/cdrom /mnt/cdrom

Linux mount host:/path_to_file_system_to_be_exported / path_to_target_mount_point

Solaris mount host:/cdrom/cdrom0 /mnt/cdrom/cdrom0

NOTE  
By default, a typical installation configures the PATROL Agent to connect through 
port 3181.
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Performing a typical installation

This section describes how to perform a typical installation of PATROL for JBoss 
Application Server.

1 Insert the PATROL for JBoss Application Server product CD in the CD-ROM. If 
you are installing on a UNIX system, mount the CD by using the mount command.

2 If the installation program did not automatically start, or if you are installing from 
an electronically downloaded installation image, start the installer. From the 
installation CD, run

■ (Windows) setup.exe

■ (UNIX) setup.sh 

If you are in a UNIX environment with no web browser, perform the following 
steps to launch the installation program:

A From a command-line prompt, change to the directory in which the installation 
utility is located.

■ Start the installation utility by using one of the following commands:
— (Windows) setup.exe -serveronly 
— (UNIX) ./setup.sh -serveronly

B On another computer with a browser, start a web browser.

C Direct the browser to the URL displayed in the message box (enter the URL in 
your browser’s Address or Go To field).

3 In the Welcome to the Installation Utility window, click Next to begin your 
installation.

4 In the Accept Licence Agreement window, select Accept, then click Next to 
continue.

5 From the Select Installation Option window, select Install products on this computer 
now, then click Next. 

6 In the Specify Installation Directory window, enter a directory path if you do not 
want to accept the default directory. 

7 Click Next to continue. 

8 Whether the computer to which you are installing is used as a monitoring console 
or as a target managed system (or both). In the Select System Roles window, 
determine the appropriate role, then click Next. 
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■ Select Common Services if you are installing to a computer that will host the 
PATROL Central Operator - Web Edition (PATROL 7.x architecture) web 
server, the PATROL Console Servers, or the RTservers. 

■ Select Console System if you are installing to a computer that will host the 
PATROL Classic Console.

■ Select Managed System if you are installing to a computer that will host a 
PATROL Agent. (This is a computer on which you run JBoss Application 
Server).

If you are not sure which option to choose, select both Console System and Managed 
System.

9 From the Select Products and Components to Install window, click + to expand the 
PATROL Solutions branch, select PATROL for JBoss AS 1.0.00, then click Next. 

10 Review the setup information on the Review Selections and Install (or Review 
Selections and Create Installable Image) window. 

If you want to change settings, click Back to go back to previous windows. 

11 Click Start Install to complete the installation. 

12 When the status window reports that installation is 100% complete, Next appears. 
Click Next to see the results window. 

13 Click View Log to review details of the installation, or click Exit to close the 
installation utility.

Importing into a distribution tool
The PATROL for JBoss Application Server can be installed locally to a single 
computer, or remotely to multiple computers using the BMC Distribution Server.

The details of how to install a product across an enterprise to multiple computers by 
using Distribution Server is beyond the scope of this book. However, this section does 
describe how to import the PATROL for JBoss Application Server product into the 
distribution tool. It also provides a high-level overview of the enterprise installation 
process that uses this product.
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Distribution Server

You can use the Distribution Server to perform remote installations or uninstallations 
of BMC distributed systems products across multiple systems from a central location.

With the Distribution Server you can

■ install, uninstall, upgrade, and reinstall products on remote systems from one 
central location

■ create collections of products and system groups to distribute multiple products to 
multiple systems in one distribution

■ schedule a distribution for a specific date and time

■ maintain multiple product versions to be distributed

■ view reports to check distribution status, gather distribution data, and diagnosis 
problems

Creating an installation package of the merged PATROL for 
JBoss Application Server

This section describes how to create an installation package that can be used with the 
installation utility to install locally on one computer, or with Distribution Server to 
install remotely on multiple computers.

To create an installation package

1 Copy the entire contents of the PATROL for JBoss Application Server CD to a 
temporary directory on a hard drive on a server. 

You can delete this temporary directory after you have successfully created an 
installable image.

2 Navigate to the packaged_results directory for the merged package and open the 
.ppf file with a text editor. 

Write down the file name in the first line of the .ppf file. This file name is the name 
of the directory that you will look for in the Products directory of the CD image.

3 Rename the packaged_results directory with the file name from the first line of the 
.ppf file.
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4 Copy the renamed directory to the Products directory of the temporary directory 
that you used in step 1. 

5 Replace the files there with the merged files that contain your customizations.

6 Copy the PATROL for JBoss Application Server CD image to the server that you 
will use to install PATROL for JBoss Application Server.

Importing a CD or custom installation package into the 
Distribution Server

This section describes how to import components into the Distribution Server for 
deployment to multiple locations.

Before You Begin

■ The customized installation packages that resulted from “Creating an installation 
package of the merged PATROL for JBoss Application Server” on page 33 must be 
accessible to the Distribution Server.

■ Ensure that you use the Distribution Server version 7.1.15 and apply any available 
patches. 

To Import components in to the Distribution Server

1 Using the Distribution Server Manager, start the Distribution Server and connect 
to it.

2 In the Distribution Server tab area, click the Components tab.

3 In the list area, click Import.

4 Navigate to the location where the components are located and click Next. 

5 Select the directory that contains the Products directory (do not select the Products 
directory itself).

EXAMPLE  
If pokckm/8.5.00/030107-233044 was listed in the first line of the .ppf file, you would use 
pokckm as the directory name.
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If the components are not accessible on a local drive, you can specify them by using 
the NFS name and path.

6 Select the check boxes for the components that you want to import and click OK.

7 To import the selected components, click Import.

Installing PATROL for JBoss Application Server using the 
Distribution Server

After you have imported the PATROL for JBoss Application Server into the 
Distribution Server, you must perform the following tasks within the tool. The tasks 
can be grouped into the following stages.

To set up products

1 On the Components tab of the Distribution Manager, import components into the 
Distribution Server repository.

2 On the Collections tab of the Distribution Manager, arrange components in 
collections.

3 On the Configurations tab of the Distribution Manager, configure the collections.

To set up systems

1 Create accounts in the operating system of the computers to which you want to 
distribute PATROL for JBoss Application Server.

2 On the Systems tab of the Distribution Manager, add accounts and create profiles 
for the systems.

EXAMPLE  
Assuming that you copied the CD image into a directory called merged_CD and then, 
after migrating your customizations and creating a customized installation package, 
you copied the updated package to the directory containing the CD image, the 
resultant directory structure would be similar to the following:
(Windows) merged_CD\Products\pmwchm 
(UNIX) merged_CD/Products/pmwchm
You would select the directory merged_CD.
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3 On the Systems tab of the Distribution Manager, add the systems and install the 
Distribution Client.

4 On the Systems tab of the Distribution Manager, arrange systems in system groups.

To distribute products

1 On the Distributions tab of the Distribution Manager, distribute configurations of 
collections to system groups.

2 On the Reports tab of the Distribution Manager, run reports to review 
distributions.

For detailed instructions about how to perform remote installations with the 
Distribution Server, see the Distribution Server Getting Started Guide. 

Considerations for using the online Help
If you plan to install the UNIX version of PATROL for JBoss Application Server on a 
PATROL Console for UNIX, you must install the supported version of the Help 
browser separately if it is not already installed. 

Browser version required for viewing the PATROL Console for 
UNIX Help

To view PATROL Help in PATROL version 3.x, the following browsers are 
supported:

■ UNIX: Netscape Navigator version 3.01 through 4.78
■ Red Hat Linux: Netscape Navigator version 4.x

PATROL Help does not support Netscape Navigator 6.0.

You must install Netscape Navigator on the computer where the PATROL Console 
resides. You can install Netscape Navigator anywhere on your UNIX computer as 
long as the binary is in the path. 

Netscape Navigator is supplied by Netscape Communications Corp. You can locate 
the browser at http://home.netscape.com/download. 
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Additional considerations for using the online Help for UNIX

When you select Help from the PATROL Console for UNIX, it may take a few 
seconds for the Help browser to launch. Two windows are displayed. First, the 
Netscape Navigator window is displayed as an icon, and then a browser window that 
contains the Help is displayed.

In addition, you must be aware of the following restrictions:

■ Because of its file-locking mechanism, Netscape Navigator displays warning 
messages when it is invoked multiple times within the same user account. It does, 
however, continue to function.

■ By default, when Netscape Navigator starts, it uses a private color map. As a 
result, you might experience color flashing on your workstation. If so, you can set 
the value of PATROL_BROWSER so that the colormap option is not specified. 
However, some subsequent color requests might fail and the online Help is 
incorrectly displayed.

■ The Exceed for Windows NT X Window Server product by Hummingbird 
Communication Ltd. might not always display the Help files correctly.

Consult your Netscape Navigator documentation to read about specific platform 
requirements and restrictions.

Required environment variables settings for the browser

The LANG, PATH, and PATROL_BROWSER environment variables must be set for 
the Help browser to run properly. The following sections describe these variables.

LANG variable

The UNIX LANG environment variable must be set to C so that Netscape Navigator 
will work properly. Otherwise, you might experience product failures. 

Type of Shell Export Command for LANG Variable

Bourne LANG=C
export LANG

Korn export LANG=C

C setenv LANG=C
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PATH variable

The PATROL user account PATH variable must contain the location of the directory 
that contains the Netscape files. If the directory containing the Netscape files is not in 
the path, add the directory to the PATROL user account path.

This requirement applies only to the PATROL user account on the PATROL Console 
computer.

PATROL_BROWSER variable

When PATROL starts the Help browser, it uses the command in the 
PATROL_BROWSER environment variable. As a default, the PATROL_BROWSER 
environment variable contains the following commands:

To use different arguments, set the value of PATROL_BROWSER to the appropriate 
string. 

Type of shell Export command for PATH variable

Bourne PATH=$PATH:/netscape_location
export PATH

Korn export PATH=$PATH:/netscape_location

C setenv PATH=$PATH:/netscape_location

Type of shell Export command for PATROL_BROWSER variable

Bourne PATROL_BROWSER=netscape -display $DISPLAY -install 
-iconic
export LANG

Korn export PATROL_BROWSER=netscape -display $DISPLAY 
-install -iconic

C setenv PATROL_BROWSER=netscape -display $DISPLAY 
-install -iconic

EXAMPLE  
For a Korn shell:

export PATROL_BROWSER=/usr/local/bin/netscape -raise
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Uninstalling PATROL for JBoss Application 
Server

To uninstall PATROL for JBoss Application Server you must use the same version of 
the installation utility that you used to install the product. Run the installation utility 
in uninstall mode to uninstall PATROL for JBoss Application Server from your 
system. 

Determining the version of the installation utility

To determine the version of the installer that is on your system, perform the following 
procedure.

1 Access a command prompt and navigate to the appropriate location:

■ (Windows) BMC_ROOT\Uninstall

■ (UNIX) BMC_ROOT/Uninstall

2 Type the following command and press ENTER. 

■ (Windows) uninstall.exe -v

■ (UNIX) ./uninstall.sh -v

WARNING  
If you use a different version of the installation program to uninstall, you might 
remove files that are needed to perform uninstallation of other BMC products. 
Chapter 2 Installing PATROL for JBoss Application Server 39



Uninstalling PATROL for JBoss Application Server
Uninstalling PATROL for JBoss Application Server on UNIX

This section describes how to uninstall PATROL for JBoss Application Server from a 
UNIX environment with or without a browser.

To uninstall individual products using the installation utility

1 Change to the Uninstall directory in your BMC Software product installation 
directory and enter the following command to launch the installation utility in 
uninstall mode: 

./uninstall.sh

2 The Welcome window is displayed, and click Next.

3 Select the installation directory from which you want to remove a product, and 
click Next.

4 Select the product or products that you want to uninstall, and click Next.

5 Review your selections and click Uninstall.

After the uninstallation is complete, a window is displayed that tells you whether 
the uninstallation was successful.

To uninstall individual products in a UNIX environment without a browser

1 If you are uninstalling from a UNIX environment without a browser perform the 
following steps to launch the installation utility:

A From a command line, change to the Uninstall directory and enter the following 
command to start the installation web server: 

./uninstall.sh -serveronly

B A message box shows the URL to use to connect to the installation web server.

C On another machine, start a browser.

D Connect to the installation web server from the browser to start the installation 
utility by using the URL that is displayed in the message box.

2 When the Welcome window is displayed, click Next.
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3 Select the installation directory from which you want to remove a product, and 
click Next.

4 Select the product or products that you want to uninstall, and click Next.

5 Review your selections and click Uninstall.

After the uninstallation is complete, a window is displayed that tells you whether 
the uninstallation was successful.

Uninstalling all products but leaving log files and 
configuration Files

This task describes how to uninstall the PATROL product but retain log files, which 
contain history for future analysis, and configuration files for redeployment.

1 Uninstall all products as described in “To uninstall individual products using the 
installation utility” on page 40.

2 Locate the uninstall.ctl file in the following directory.

(UNIX only) BMC_Products_Installation_directory/Uninstall/Install/instdata 

3 Open the uninstall.ctl file in a text editor, and edit the /BMC/Base variable to specify 
the name of the directory from which you removed the products in step 1. 

4 Open a command-line prompt.

5 Change to the following directory.

(UNIX only) BMC_Products_Installation_directory/Uninstall/Install/ instbin

6 Enter the following commands: 

(UNIX only) thorinst.sh -uninstall path_to_control_file -log path_to_log_file -output 
path_to_output_log_file

Use the following table to help determine the log file and output log file locations:
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Example (UNIX only)

If /opt/bmc is your product installation directory, you would change to 
/opt/bmc/Uninstall/Install/instbin directory and enter the following command:

This action removes all installation files and directories except those that are used by 
the utility when the uninstallation is performed. Log files, configuration files, and 
user-modified files are also retained.

Uninstalling all products, associated log files, and 
configuration files

This section describes how to remove all PATROL products and related log files and 
configuration files from your UNIX environment. Once these files have been 
removed, you cannot recover them unless you have made a backup copy of the 
installation.

Option Description Value

-log Sends the log information to a 
standard log file.

This file contains all installation 
status information.

path to log file;
any valid path and file 
name (with a .txt 
extension) 

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.

-output Sends the log information to an 
output log file.

This file contains all messages about 
the progress of the installation that 
are normally sent to standard 
output.

path to output log file;
any valid path and file 
name (with a .txt 
extension)

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.

thorinst.sh -uninstall 
“/opt/bmc/Uninstall/Install/instdata/uninstall.ctl” -log 
/var/logs/NetworkLogs/MyLogs.txt -output 
/var/adm/NetworkLogs/MyLogs.out
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1 Uninstall all products as described in “To uninstall individual products using the 
installation utility” on page 40.

2 Locate the uninstall-all.ctl file in the following directory.

(UNIX only) BMC_Products_Installation_directory/Uninstall/Install/instdata 

3 Open the uninstall-all.ctl file in a text editor, and edit the /BMC/Base variable to 
specify the name of the directory from which you removed the products in step 1. 

4 Open a command line prompt.

5 Change to the following directory.

(UNIX only) BMC_Products_Installation_directory/Uninstall/Install/instbin

6 Enter the following command.

(UNIX only) thorinst.sh -uninstall path_to_control_file -log path_to_log_file -output 
path_to_output_log_file

Use the following table to determine the log file and output log file locations:

Option Description Value

-log Sends the log information to a 
standard log file.

This file contains all installation 
status information.

path to log file;
any valid path and file 
name (with a .txt 
extension)

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.

-output Sends the log information to an 
output log file.

This file contains all messages about 
the progress of the installation that 
are normally sent to standard 
output.

path to log file;
any valid path and file 
name (with a .txt 
extension)

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.
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Example (UNIX only)

If /opt/bmc is your product installation directory, you would change to 
/opt/bmc/Uninstall/Install/instbin directory and enter the following command:

This action removes all installation files and directories. The files that were used to 
perform the uninstallation are marked for deletion and will be removed when the 
computer on which the products were uninstalled is rebooted. 

Uninstalling PATROL for JBoss Application Server on Windows

You can uninstall PATROL for JBoss Application Server by using the option for 
specifying what you want to uninstall. The following procedures describe how to 
uninstall products and all related log files from a Windows environment.

To uninstall individual products

1 From the Uninstall directory in your BMC Software product installation directory, 
double-click uninstall.exe to launch the installation utility in uninstall mode.

The Welcome window is displayed. Click Next.

2 Select the installation directory from which you want to remove a product, and 
click Next.

3 Select the product or products that you want to uninstall, and click Next.

4 Review your selections, and click Uninstall.

After the uninstallation is complete, a window is displayed that tells you whether the 
uninstallation was successful.

thorinst.sh -uninstall 
“/opt/bmc/Uninstall/Install/instdata/uninstall-all.ctl” -log 
/var/logs/NetworkLogs/MyLogs.txt -output 
/var/adm/NetworkLogs/MyLogs.out

NOTE  
As an option, you can launch the installation utility in uninstall mode by choosing 
Start => Settings => Control Panel => Add/Remove Programs and double-clicking 
BMC Software Tools in the Add/Remove Programs Properties dialog box.
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Uninstalling all products but leaving log files and 
configuration files

This section describes how to uninstall the PATROL product but retain log files, 
which contain history for future analysis, and configuration files for redeployment.

1 Uninstall all products as described in “To uninstall individual products” on 
page 44.

2 Locate the uninstall.ctl file in the following directory.

(Windows only) BMC_Products_Installation_directory\Uninstall\Install\instdata 

3 Open the uninstall.ctl file in a text editor, and edit the /BMC/Base variable to specify 
the name of the directory from which you removed the products in step 1. 

4 Open a command-line prompt.

5 Change to the following directory.

(Windows only) BMC_Products_Installation_directory\Uninstall\Install\ instbin

6 Enter the following command.

(Windows only) thorinst.exe -uninstall path_to_control_file -log path_to_log_file 
-output path_to_output_log_file
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Use the following table to help determine the log file and output log file locations:

Example (Windows only)

If C:\Program Files\BMC Software is your product installation directory, you would 
change to the C:\Program Files\BMC Software\Uninstall\ Install\instbin directory and 
enter the following command:

This action removes all installation files and directories except those that are used by 
the utility at the time the uninstallation was performed. Log files, configuration files, 
and user-modified files are also retained.

Uninstalling all products, associated log files, and 
configuration files

This section describes how to remove all PATROL products and related log files and 
configuration files from your Windows environment. Once these files have been 
removed, you cannot recover them unless you have made a backup copy of the 
installation.

Option Description Value

-log Sends the log information to a 
standard log file.

This file contains all installation 
status information.

path to log file;
any valid path and file 
name (with a .txt 
extension) 

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.

-output Sends the log information to an 
output log file.

This file contains all messages about 
the progress of the installation that 
are normally sent to standard 
output.

path to output log file;
any valid path and file 
name (with a .txt 
extension)

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.

thorinst.exe -uninstall “C:\Program Files\BMC 
Software\Uninstall\Install\instdata\uninstall.ctl” -log 
Z:\NetworkLogs\MyLogs.txt -output Z:\NetworkLogs\MyLogs.out
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1 Uninstall all products as described in “To uninstall individual products” on 
page 44.

2 Locate the uninstall-all.ctl file in the following directory.

(Windows only) BMC_Products_Installation_directory\Uninstall\Install\instdata

3 Open the uninstall-all.ctl file in a text editor, and edit the /BMC/Base variable to 
specify the name of the directory from which you removed the products in step 1. 

4 Open a command-line prompt.

5 Change to the following directory.

(Windows only) BMC_Products_Installation_directory\Uninstall\Install\instbin

6 Enter the following command.

(Windows only) thorinst.exe -uninstall path_to_control_file -log path_to_log_file 
-output path_to_output_log_file

Use the following table to help determine the log file and output log file locations:

Option Description Value

-log ends the log information to a 
standard log file

This file contains all installation 
status information.

path to log file;
any valid path and file 
name (with a .txt 
extension)

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.

-output sends the log information to an 
output log file

This file contains all messages about 
the progress of the installation that 
are normally sent to standard 
output.

path to log file;
any valid path and file 
name (with a .txt 
extension)

If a space exists in the path, 
the entire path must be 
enclosed in quotation 
marks.
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Where to go from here
Example (Windows only)

If C:\Program Files\BMC Software is your product installation directory, you would 
change to the C:\Program Files\BMC Software\Uninstall\ Install\instbin directory and 
enter the following command:

This action removes all installation files and directories. The files that were used to 
perform the uninstallation are marked for deletion and will be removed when the 
computer on which the products were uninstalled is rebooted. 

Where to go from here
After installation is complete, turn to Chapter 3, “Configuration” for information 
about configuring PATROL for JBoss Application Server.

thorinst.exe -uninstall “C:\Program Files\BMC 
Software\Uninstall\Install\instdata\uninstall-all.ctl” -log 
Z:\NetworkLogs\MyLogs.txt -output Z:\NetworkLogs\MyLogs.out
48 PATROL for JBoss Application Server User Guide



C h a p t e r 3

3  Configuration

After you install PATROL for JBoss Application Server, you must load the 
Knowledge Modules (KMs) into the PATROL Console and configure the product. 
This chapter contains the following topics:

Loading PATROL for JBoss Application Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49
Initial KM setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Registering a JBoss environment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
Enabling and disabling Java debugging  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
Enabling and disabling PSL debugging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
Selecting collection categories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54

Verifying discovery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55
Resolving potential setup problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Editing a JBoss environment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
Unregistering a JBoss environment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58

Loading PATROL for JBoss Application Server
After you install PATROL for JBoss Application Server, you must load the product 
KM into the PATROL Console.

Before loading the product:

■ start a PATROL Console
■ start a PATROL Agent on each machine that you want to monitor 

NOTE  
Before the KM can successfully operate with JBoss Application Server, a default login 
shell must be defined that is valid for both the JBoss Administration Account and the 
PATROL Default User Account, as explained in “Default login shell” on page 29.
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1. Add those hosts on which PATROL for JBoss Application Server is running to the 
PATROL Console by selecting Hosts => Add.

2. Load the product knowledge files. From the PATROL Console menu, select File => 
Load KM... 

The product knowledge files are loaded.

3. Select the PJB.kml file, and then click Open.

4. From the PATROL Console menu, select File => Save Configuration. Save your 
console configuration so that PATROL automatically loads the selected KM the 
next time you start the PATROL Console. 

Initial KM setup
Initial KM setup consists of providing configuration information that defines your 
JBoss Application Server environment to the PATROL monitoring environment.

NOTE  
PATROL for JBoss Application Server can start even if no JBoss Application Server is 
running. However, in this case only the highest level icons are generated.
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Registering a JBoss environment

This section describes the process of registering a new JBoss environment.

1 Access the JBossSetup icon and select KM Commands => Register New Environment. 

Figure 4 Register JBoss environment dialog

2 In the Register JBoss environment dialog box, enter the host name of a local or 
remote host in the Host name text box.

You can enter either a host name or an IP address in the Host name text box. IP 
addresses can be in the IPv4 or IPv6 format.

3 Enter the JMX port number that the KM will use in the JMX port text box.

EXAMPLE  
[2001:db8:28:3:f98a:5b31:67b7:67ef] is an IPv6 address.
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4 (Optional) Enter a valid JBoss Application Server account user name in the JBoss 
user name text box.

5 (Optional) Enter the password for the JBoss Application Server account in the JBoss 
password text box.

6 Enter the path of the directory in which JBoss Application Server is installed on the 
local host in the JBoss home text box.

7 Enter the path of the directory in which Java is installed on the local host in the Java 
home text box. PATROL for JBoss Application Server supports only version 1.6 of 
Oracle® JRE (Java Runtime Environment).

8 Enter a valid operating system user name for the computer on which Jboss 
Application Server is installed in the OS user name text box.

NOTE  
The default value of the JMX port number depends on the version of JBoss. For 
JBoss 4 and JBoss 5, the default value is 1099. For JBoss 6, the default value is 1090.

■ For JBoss 4, the JMX port number is defined by the jboss:service=Naming mbean 
at the Port attribute in the JBOSS_HOME/server/ServerName/conf/jboss-service.xml 
file.

■ For JBoss 5, the JMX port number is defined by the jboss:service=Naming mbean 
at the Port attribute in the 
JBOSS_HOME/server/ServerName/conf/bindingservice.beans/META-INF/bindings-j
boss-beans.xml file.

■ For JBoss 6, the JMX port number is defined by the 
jboss.remoting:service=JMXConnectorServer,protocol=rmi mbean at the port 
attribute in the 
JBOSS_HOME/server/ServerName/conf/bindingservice.beans/META-INF/bindings-j
boss-beans.xml file.

NOTE  
JBoss user name and JBoss password are optional, only if both text boxes are left 
blank.

NOTE  
The version of JBoss installed on the local host must be the same as on the 
monitored server.
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9 Enter the password for the operating system user account in the OS password text 
box.

10 Click the Clustered or Standalone to select the data collection mode in the Set 
collection mode panel.

11 Click OK.

Enabling and disabling Java debugging

To enable or disable Java debugging for a JBoss environment, access the icon of the 
JBoss environment, and select KM Commands => Debug => Toggle Java Debug.

This option toggles the activation of Java debugging. If Java debugging is currently 
disabled, selecting this option enables it. Alternately, if Java debugging is currently 
enabled, selecting this option disables it.

Enabling and disabling PSL debugging

To enable or disable PSL debugging for a JBoss environment, access the icon of the 
JBoss environment, and select KM Commands => Debug => Toggle PSL Debug.

This option toggles the activation of PSL debugging. If PSL debugging is currently 
disabled, selecting this option enables it. Alternately, if PSL debugging is currently 
enabled, selecting this option disables it.

NOTE  
The operating system user account must have read and execute permissions for the 
JBoss home directory, execute permissions for the Java home directory, and full 
access to the ../Patrol3/PJB_JBoss directory.

PATROL for JBoss Application Server supports RMI authentication for JBoss 4 and 
JBoss 5, and JSR-160 authentication for JBoss 6.

NOTE  
You must set the value of the default javaLogFilePath pconfig variable before you can 
use the Java debug functionality. This enables the environment-specific version of the 
javaLogFilePath pconfig variable for any new JBoss environment that you register.

For more information, see the javaLogFilePath pconfig variable on pages 92 and 92.
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Selecting collection categories

You can select or change the collection categories that are being used by a JBoss 
environment at any time.

1 Access the icon of the JBoss environment, and select KM Commands => Select 
Collection Categories.

2 In the Select collection categories dialog box, select the check boxes of all the 
collection categories that you want to use. To disable a collection category, clear 
the corresponding check box.

3 Click OK.

After you have completed initial setup, verify that all the JBoss objects that you expect 
have been discovered by following instructions in “Verifying discovery” on page 55.

NOTE  
You must set the value of the default logFileName pconfig variable before you can 
use the PSL debug functionality. For more information, see “logFileName” on 
page 92.

NOTE  
The collection categories that you select are applied for all servers in the JBoss 
environment.

If you unselect any of the collection categories later, only data collection is stopped. 
The category itself does not get deleted from the GUI.
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Verifying discovery
After you have set up your JBoss Application Server, verify that the JBoss icon 
appears in the PATROL Console. Verify that all servers, containers, and instances that 
you expect to see are discovered and are displaying appropriate performance data.

1. From the PatrolMainMap, open the computer window and verify that the JBoss 
icon is present. The icon in the following figure is a container that represents the 
environment under a JBoss administration server.

Figure 5 JBoss Icons in PATROL Console

2. Double-click the JBoss icon to see which application servers are being monitored. 

There are as many application server instances at this level as you registered. If 
you went through the configuration process only once for a single server, you see 
one server instance icon.

To add more servers, repeat the setup process described on page 50.

3. Double-click a server instance icon. 

Icon representing a JBoss environment
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In the PATROL window, you should see several icons, that correspond to the 
container application classes described in Chapter 1, “Product components and 
capabilities.” 

4. Double-click one of the container icons. You should see subservices or parameters 
that you selected for activation. If you do not see the parameters or subservices 
that you expected, you might have missed a step in setting up performance 
monitoring, including setting the application server to the required performance 
monitoring level. 

5. Continue double-clicking container icons and reviewing parameters until you are 
satisfied that the system is being correctly monitored.

Resolving potential setup problems

If your JBoss environment is not fully discovered or performance parameters are 
missing or incorrect, it might indicate one of the following configuration problems:

■ Communication with the JBoss Application Server fails: If communication with the 
JBoss server fails, check to see if you entered the correct setup parameters while 
setting up the JBoss environment. See “Editing a JBoss environment” on page 3-57.

■ Monitoring for the JBoss Application Server fails to start: If monitoring fails to start 
for the JBoss Application Server, ensure that you entered a valid OS User Name, 
and OS Password while setting up the JBoss environment.
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■ PATROL Agent is unable to read data received through the channel for the Jboss 
environment: If the PATROL Agent fails to read data received from the JBoss 
environment, restart the PATROL Agent.

Where to go from here

You are now ready to monitor and manage your JBoss Application Server 
environment. For the KM to interact successfully with JBoss Application Server, the 
right accounts must be in place and have the access that they require.

For information about changing the settings in your JBoss Application Server 
environment, see “Editing a JBoss environment” on page 57.

For information about removing JBoss Application Server environments from 
PATROL Console, see “Unregistering a JBoss environment” on page 58.

For information about parameters, menu commands, or detailed information about 
using features of PATROL for JBoss Application Server, see the other chapters in this 
user guide, or see the Help.

Editing a JBoss environment
This section describes the process of changing the settings in an existing JBoss 
environment.

1 Access the icon of the JBoss environment, and select KM Commands => Edit 
Environment.

2 In the Edit JBoss environment dialog box, modify the JBoss environment setting as 
needed. 

For more information about the fields that you can modify in the Edit JBoss 
environment dialog box, refer to “Registering a JBoss environment” on page 51.

3 Click OK.

NOTE  
■ You cannot change the name of a JBoss environment after you register it. The 

Environment name field in the Edit JBoss environment dialog box is read-only.

■ If you change the host name, JMX port, or collection mode, the existing JBoss 
environment configuration will be deleted.
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Unregistering a JBoss environment
This section describes the process of removing an existing JBoss environment.

1 Access the icon of the JBoss environment, and select KM Commands => Unregister 
Environment.

2 Click OK.
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A p p e n d i x A

A  Accessing menu commands, 
InfoBoxes, and online Help

BMC Software offers several PATROL consoles from which you can view a PATROL 
Knowledge Module (KM). Because of the different environments in which these 
consoles run, each one uses a different method to display and access information in 
the KM. This appendix provides instructions for accessing the KM menu commands, 
InfoBoxes, and online Help on each of the PATROL consoles. See the PATROL for 
JBoss Application Server online Help for more detailed information about navigation 
in the PATROL Consoles.

Accessing KM commands and InfoBoxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
Accessing online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

Accessing KM commands and InfoBoxes
Table 5 provides information about how to access KM commands and InfoBoxes 
from the various PATROL consoles. 
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Accessing online Help
Accessing online Help
Table 6 on page 61 provides information about how to access Help from each console.

Table 5 Accessing KM Commands and InfoBoxes 

Console
To access 
menu commands

To access
InfoBoxes

PATROL Console for Microsoft 
Windows Servers

In either the Desktop tree tab or 
work area, right-click a 
computer or application icon 
and select KM Commands from 
the pop-up menu.

In either the Desktop tree tab or 
the work area, right-click an 
application class or parameter 
icon and select InfoBox from the 
pop-up menu.

PATROL Console for Unix In the work area, right-click a 
computer or application icon to 
display a pop-up menu that 
contains KM-specific 
commands. 

With the middle mouse button, 
click an application class or 
parameter icon.

PATROL Central Operator - 
Windows Edition

In the navigation pane, 
right-click a managed system or 
application icon and select 
Knowledge Module 
Commands from the pop-up 
menu.

In the navigation pane, 
right-click a PATROL object 
and select InfoBox from the 
pop-up menu.

PATROL Central Operator - 
Web Edition

In the tree view area, right-click 
an application icon and select 
Knowledge Module Commands 
from the pop-up menu.

In the tree view area, right-click 
a PATROL object and select 
Infobox from the pop-up menu.

NOTE  
If you are trying to access Help from a UNIX console, see the PATROL Installation 
Reference Manual for specific instructions about installing and setting up a browser in 
the UNIX environment. 
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Accessing online Help
Table 6 Accessing online Help

Console
To access 
product Help

To access 
application class Help

To access parameter 
Help

PATROL Console 
for Microsoft 
Windows Servers

■ Right-click the 
product application 
icon and select KM 
Commands => 
Product Help.

■ From the console 
menu bar, select 
Help => Help 
Topics => PATROL 
Knowledge 
Modules.

Double-click an 
application class in the 
KM tab of the console. 
From the Application 
Properties dialog box, 
click the Help tab. Then 
click Show Help.

■ Right-click a 
parameter icon and 
select Help On from 
the pop-up menu.

■ Double-click a 
parameter icon; click 
the ? icon or Help 
button in the 
parameter display 
window.

■ Double-click a 
parameter in the KM 
tab of the console; 
from the properties 
dialog box, click the 
Help tab; then click 
Show Help.

PATROL Console 
for Unix

■ Right-click the 
product application 
icon and select KM 
Commands => 
Product Help.

■ From the console 
menu bar, select 
Help On => 
Knowledge 
Modules.

Select Attributes => 
Application Classes and 
double-click the 
application name. Click 
Show Help in the 
Application Definition 
dialog box.

Right-click a parameter 
icon and click Help On.

PATROL Central 
Operator - 
Windows Edition

From the console menu 
bar, select Help => Help 
Topics. In the Contents 
tab, click the name of 
your product.

In the Operator tab of 
the navigation pane, 
select an application 
icon and press F1.

In the Operator tab of 
the navigation pane, 
select a parameter icon 
and press F1.

PATROL Central 
Operator - Web 
Edition

In the upper right corner 
of PATROL Central, 
click Help and select 
PATROL KM Help.

In the tree view, 
right-click an 
application class and 
select Help.

In the tree view, 
right-click a parameter 
and select Help.
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A p p e n d i x B

B  Parameter reference

The PATROL for JBoss Application Server product contains many parameters that 
provide statistical information about resources, operating status, and performance. 

Some of the parameters are available for use with only one version of JBoss 
Application Server. This information is noted below each parameter description.

This appendix contains the following sections:

Column headings defined. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63
Abbreviations defined. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65
Core parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65

Column headings defined
Column headings in Table 7 are defined as follows: 

Description states the parameter name and describes the parameter’s 
function; for consumer parameters, lists the collector parameters 
that gather the data displayed by this parameter

Active? indicates two things:

■ whether a parameter is active by default–this information is 
reflected in the words yes or no

■ whether a parameter requires that JVM profiling or J2EE 
bytecode instrumentation be activated through the service 
setup process as explained in –if this information applies, it 
will appear as a second line in the cell with the word prof or 
inst

Note: BMC Software recommends that profiling be used only in 
test and development environments.
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Column headings defined
Parameter
Type

indicates the parameter type: standard (std) gathers and displays 
a single data value; collector (coll) gathers multiple data values 
but has no display capabilities; consumer (con) displays values 
gathered by collector or standard parameters. Some standards 
have collector properties. 

Alarm1
Rangea

specifies the thresholds for the first-level alarm; not applicable to 
collector parameters

Alarm2
Rangea

specifies the thresholds for the second-level alarm; not applicable 
to collector parameters

Scheduling
(poll time)

specifies how frequently the parameter will run and collect data 
(polling cycle); not applicable to consumer parameters

Icon Style specifies whether the parameter is represented as a graph, gauge, 
text box, stop light (signal), or boolean state

Unit specifies the unit of measure in which the parameter output is 
expressed, such as a percentage, a number, or bytes

aBorder, Alarm1, and Alarm2 ranges that are also labeled inactive by default may not be 
recommended ranges for the parameter. 
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Abbreviations defined
Abbreviations defined
The following abbreviations may be used in Table 7:

Core parameters
The parameters in this table constitute the largest group of parameters in the KM, and 
apply to the application classes beginning with the PJB_ prefix.

bool Boolean; shows a state, such as on or off, OK or not OK

coll collector parameter

con consumer parameter

disc discovery; refers to the PATROL discovery process

GB gigabyte or gigabytes

hr hour or hours

KB kilobyte or kilobytes

MB megabyte or megabytes

MHz megahertz

min minute or minutes 

msec millisecond or milliseconds

NA not applicable; a value cannot be set

nsec nanosecond or nanoseconds

sec second or seconds

std standard parameter

TB terabyte or terabytes

undef undefined; a value can be set, but no default is provided

warn warning; type of alert
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PJB_CLUSTER application class

ClusterAvailability (PJP_CLUSTER)

Displays the availability of the cluster during the 
collection interval

Collector: ClusterStatus
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph %

ClusterStatus (PJP_CLUSTER)

Displays the status of the cluster, based on the activity 
status of the servers within the cluster.

Collector: ServerStatus
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef State 
Boolea
n

0=Ok, 
1=Not Ok

PJB_CLUSTERED_SERVER application class 
ServerStatus (PJB_CLUSTERED_SERVER )

Displays the status of the server.

Collector: ClusterStatus
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef State 
Boolea
n

0=Ok, 
1=Not Ok

PJB_CONNECTION_THREAD_POOL application class
CurrentThreadCount (PJB_CONNECTION_POOL 
THREAD)

Displays the current number of threads.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
threads

CurrentThreadsBusy 
(PJB_CONNECTION_POOL THREAD)

Displays the current number of busy threads

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
threads

PJB_EJB2 application class
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Core parameters
CacheSize (PJB_EJB2)

Displays the size of the cache.

Collector: collectCategories
JBOSS version: 5.0, 6.0

yes con undef undef undef graph number of 
bean 
instances

CreateCount (PJB_EJB2)

Displays the number of EJB2 session bean instances 
created since the server was most recently started.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
bean 
instances

CurrentSize (PJB_EJB2)

Displays the number of EJB2 session bean instances in 
the pool.

Collector: collectCategories
JBOSS version: 5.0, 6.0

yes con undef undef undef graph number of 
bean 
instances

MaxSize (PJB_EJB2)

Displays the maximum number of EJB2 session beans 
in the pool.

Collector: collectCategories
JBOSS version: 5.0, 6.0

yes con undef undef undef graph number of 
bean 
instances

PassivatedCount (PJB_EJB2)

Displays the current number of passivated session 
beans.

Collector: collectCategories
JBOSS version: 5.0, 6.0

yes con undef undef undef graph number of 
passivated 
session 
beans

RemoveCount (PJB_EJB2)

Displays the number of EJB2 session bean instances 
that have been removed since the server was most 
recently started.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
session 
bean 
instances
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Core parameters
PJB_EJB3 application class
AvailableCount (PJB_EJB3)

Displays the number of available EJB3 session bean 
instances in the pool

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
session 
bean 
instances

CreateCount (PJB_EJB3)

Displays the number of EJB3 session bean instances 
that have been created since the server was most 
recently started.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
session 
bean 
instances

CurrentSize (PJB_EJB3)

Current number of EJB3 session bean instances in the 
pool.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
session 
bean 
instances

MaxSize (PJB_EJB3)

Displays the maximum number of EJB3 session bean 
instances in the pool.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
session 
bean 
instances

RemoveCount (PJB_EJB3)

Displays the number of EJB3 session bean instances 
removed since the server was most recently started.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
session 
bean 
instances

PJB_ENVIRONMENT application class 
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Core parameters
RegistrationStatus (PJB_ENVIRONMENT)

Displays the registration status of the JBoss 
environment.

Collector: RegistrationStatus
JBOSS version: 4.0, 5.0, 6.0

yes stand
ard

1 undef 1 min State 
Boolea
n

0=Ok, 
1=Not Ok

PJB_GARBAGE_COLLECTION application class 

CollectionCount (PJB_GARBAGE_COLLECTION)

Displays the number of collections performed of 
unused objects.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
collections

CollectionTime (PJB_GARBAGE_COLLECTION)

Displays the duration of the collection process.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph sec

PJB_JCA application class
AvailableConnectionCount (PJB_JCA)

Displays the number of available connections (MBean 
attribute.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
available 
connections

BackGroundValidationMillis (PJB_JCA)

Displays the duration in milliseconds taken to perform 
background validation.

Collector: collectCategories
JBOSS version: 5.0, 6.0

yes con undef undef undef graph ms

BlockingTimeoutMillis (PJB_JCA)

Displays the duration in milliseconds of the Blocking 
timeout.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms
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Core parameters
ConnectionCount (PJB_JCA)

Displays the number of connections (MBean attribute)

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

ConnectionCreatedCount (PJB_JCA)

Displays the number of connections created (MBean 
attribute)

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

ConnectionDestroyedCount (PJB_JCA)

Displays the number of destroyed connections 
(MBean attribute)

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

IdleTimeoutMinutes (PJB_JCA)

Displays the duration in minutes of Idle timeout.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph minutes

InUseConnectionCount (PJB_JCA)

Displays the number of connections currently in use 
(MBean attribute).

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

MaxSize (PJB_JCA)

Displays the maximum size of the MBean.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections
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Core parameters
MinSize (PJB_JCA)

Displays the minimum size of the MBean

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

PJB_JCA_V4 application class 
AvailableConnectionCount (PJB_JCA_V4)

Displays the number of available connections (MBean 
attribute.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
available 
connections

BackGroundValidationMinutes (PJB_JCA_V4)

Displays the duration in minutes taken to perform 
background validation

Collector: collectCategories
JBOSS version: 4.0

yes con undef undef undef graph  minutes

BlockingTimeoutMillis (PJB_JCA_V4)

Displays the duration in milliseconds of Blocking 
timeout.

Collector: collectCategories
JBOSS version: 4.0

yes con undef undef undef graph ms

ConnectionCount (PJB_JCA_V4)

Displays the number of connections (MBean attribute)

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

ConnectionCreatedCount (PJB_JCA_V4)

Displays the number of connections created (MBean 
attribute)

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections
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Core parameters
ConnectionDestroyedCount (PJB_JCA_V4)

Displays the number of destroyed connections 
(MBean attribute)

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

IdleTimeoutMinutes (PJB_JCA_V4)

Displays the duration in minutes of Idle timeout.

Collector: collectCategories
JBOSS version: 4.0

yes con undef undef undef graph  minutes

InUseConnectionCount (PJB_JCA_V4)

Displays the number of connections currently in use

Collector: collectCategories
JBOSS version: 4.0

yes con undef undef undef graph number of 
connections 

MaxSize (PJB_JCA_V4)

Displays the maximum size of the MBean.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

MinSize (PJB_JCA_V4)

Displays the minimum size of the MBean

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
connections

PJB_JMS_QUEUE application class 

ConsumerCount (PJB_JMS_QUEUE)

Displays the number of current consumers.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
consumers 

Table 7 PATROL for JBoss Application Server core parameters  (Part 7 of 20)

A
ct

iv
e?

 

Ty
pe

 

W
ar

ni
ng

(A
la

rm
1)

 

A
la

rm
(A

la
rm

2)
 

Sc
he

du
lin

g

Ic
on

 

U
ni

ts
 

72 PATROL for JBoss Application Server User Guide



Core parameters
DeliveringCount (PJB_JMS_QUEUE)

Displays the number of unacknowledged messages in 
this queue being delivered.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
messages 

MessagesAdded (PJB_JMS_QUEUE)

Displays the number of messages added to this queue 
since it was initially created.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
messages 

MessageCount (PJB_JMS_QUEUE)

Number of messages waiting for delivery in this 
queue.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
messages 

ScheduledCount (PJB_JMS_QUEUE)

Number of scheduled messages in this queue waiting 
for scheduled delivery.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
messages 

JB_JMS_QUEUE_V4 application class 
MessageCount (PJB_JMS_QUEUE_V4)

Displays the number of messages waiting for delivery 
in this queue.

Collector: collectCategories
JBOSS version: 4.0

yes con undef undef undef graph number of 
messages

ScheduledCount (PJB_JMS_QUEUE_V4)

Displays the number of scheduled messages in this 
queue waiting for scheduled delivery.

Collector: collectCategories
JBOSS version: 4.0

yes con undef undef undef graph number of 
messages

PJB_JMS_QUEUE_V5 application class
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Core parameters
ConsumerCount (PJB_JMS_QUEUE_V5)

Displays current number of consumers

Collector: collectCategories
JBOSS version: 5.0

yes con undef undef undef graph number of 
consumers

DeliveringCount (PJB_JMS_QUEUE_V5)

Displays number of unacknowledged messages in this 
queue being delivered.

Collector: collectCategories
JBOSS version: 5.0

yes con undef undef undef graph number of 
messages

MessageCount (PJB_JMS_QUEUE_V5)

Displays number of messages awaiting delivery in this 
queue.

Collector: collectCategories
JBOSS version: 5.0

yes con undef undef undef graph number of 
messages

ScheduledCount (PJB_JMS_QUEUE_V5)

Displays the number of scheduled messages in this 
queue awaiting delivery

Collector: collectCategories
JBOSS version: 5.0

yes con undef undef undef graph number of 
messages

PJB_JMS_TOPIC application class 

DurableMessageCount (PJB_JMS_TOPIC)

Displays the number of messages sent to all durable 
subscribers to this topic.

Collector: collectCategories
JBOSS version: 4.0, 5.0,6.0

yes con undef undef undef graph number of 
messages

DurableSubscriptionCount (PJB_JMS_TOPIC)

Displays the number of durable subscribers to this 
topic.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
subscribers
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Core parameters
MessageCount (PJB_JMS_TOPIC)

Displays the number of messages sent to all 
subscribers to this topic.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
messages

NonDurableMessageCount (PJB_JMS_TOPIC)

Displays the number of messages sent to all 
non-durable subscribers to this topic.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
messages

NonDurableSubscriptionCount (PJB_JMS_TOPIC)

Displays the number of non-durable subscribers to 
this topic.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
subscribers

SubscriptionCount (PJB_JMS_TOPIC)

Displays the total number of (durable and 
non-durable) subscribers to this topic.

Collector: collectCategories
JBOSS version: 4.0, 5.0,6.0

yes con undef undef undef graph number of 
subscribers

PJB_JSP application class
JSPCount (PJB_JSP)

Displays the number of Java server pages that have 
been loaded to a webapp.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
Java server 
pages

JSPReloadCount (PJB_JSP)

Displays the number of of Java server pages that have 
been reloaded to a webapp.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
Java server 
pages
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Core parameters
PJB_JTA application class 
NumberOfAbortedTransactions (PJB_JTA)

Displays the number of aborted transactions.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions

NumberOfApplicationRollbacks (PJB_JTA)

Displays the number of application transactions that 
have been rolled back (MBean attribute).

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions

NumberOfCommittedTransactions (PJB_JTA)

Displays the number of transactions that have been 
committed since startup (MBean attribute).

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions

NumberOfHeuristics (PJB_JTA)

Displays the number of heuristics

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
heuristics

NumberOfInflightTransactions (PJB_JTA)

Displays the number of inflight transactions (MBean 
attribute).

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions

NumberOfNestedTransations (PJB_JTA)

Displays the number of nested transactions (MBean 
attribute).

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions
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Core parameters
NumberOfResourceRollbacks (PJB_JTA)

Displays the number of resource transactions that 
have been rolled back (MBean attribute)

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions

NumberOfTimedOutTransactions (PJB_JTA)

Displays the number of timed-out transactions 
(MBean attribute.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions

NumberOfTransactions (PJB_JTA)

Displays the number of transactions currently open 
(MBean attribute

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
transactions

PJB_JVM application class 

ActiveThreadCount (PJB_JVM)

Displays the number of active threads.

Collector: collectCategories
JBOSS version: 4.0, 5.0

yes con undef undef undef graph number of 
threads

ActiveThreadGroupCount (PJB_JVM)

Displays the number of active thread groups.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
groups

FreeMemory (PJB_JVM)

Displays the amount of available free memory in the 
JVM heap.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph Mbyte
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Core parameters
MaxMemory (PJB_JVM)

Displays the maximum amount of memory allocated 
to the JVM heap.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph Mbyte

MemoryUsage (PJB_JVM)

Displays the memory in use expressed as a percentage 
of total memory.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef 5 min graph %

TotalMemory (PJB_JVM)

Displays the current size of the JVM heap.

Collector: collectCategories
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph Mbyte

PJB_JVM_CLASSLOADING application class

LoadedClassCount (PJB_JVM_CLASSLOADING)

Displays the number of classes currently loaded in the 
virtual machine.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
classes

TotalLoadedClassCount 
(PJB_JVM_CLASSLOADING)

Displays the number of classes loaded since starting 
the virtual machine

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
classes

Table 7 PATROL for JBoss Application Server core parameters  (Part 13 of 20)

A
ct

iv
e?

 

Ty
pe

 

W
ar

ni
ng

(A
la

rm
1)

 

A
la

rm
(A

la
rm

2)
 

Sc
he

du
lin

g

Ic
on

 

U
ni

ts
 

78 PATROL for JBoss Application Server User Guide



Core parameters
UnloadedClassCount (PJB_JVM_CLASSLOADING)

Number of classes unloaded since starting the virtual 
machine.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
classes

PJB_JVM_OS application class

CommittedVirtualMemorySize (PJB_JVM_OS)

Displays the size of virtual memory used by the JVM.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph Mbyte

FreePhysicalMemorySize (PJB_JVM_OS)

Displays the amount of free physical memory 
available to the operating system.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph Mbyte

FreeSwapSpaceSize (PJB_JVM_OS)

Displays the amount of free swap space available to 
the operating system.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph Mbyte

OpenFileDescriptorCount (PJB_JVM_OS)

Displays the number of open file descriptors.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
file 
descriptors

PJB_JVM_THREAD application class
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Core parameters
DaemonThreadCount (PJB_JVM_THREAD)

Displays the number of daemon threads in the system.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

PeakThreadCount (PJB_JVM_THREAD)

Displays the peak number of threads in the system.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

ThreadCount (PJB_JVM_THREAD)

Displays the number of active threads in the system.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

TotalStartedThreadCount (PJB_JVM_THREAD)

Displays the number of threads initiated in the system 
since the server was most recently started.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

PJB_MEMORY_POOL application class

CollectionUsageThreshold (PJB_MEMORY_POOL)

Displays the memory in KB remaining in memory 
pool after garbage collection

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
KB
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Core parameters
CollectionUsageThresholdCount 
(PJB_MEMORY_POOL)

Displays the number of times that garbage collection 
has been performed since the the server was most 
recently started.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
times

UsageThreshold (PJB_MEMORY_POOL)

Displays the current value in KB of the memory pool 
usage threshold.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
KB

UsageThresholdCount (PJB_MEMORY_POOL)

Displays the number of times that the usage threshold 
has been reached.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
times

PJB_QUEUE_THREAD_POOL application class
CurrentThreadCount 
(PJB_QUEUE_THREAD_POOL)

Displays the current number of threads.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

LargestThreadCount (PJB_QUEUE_THREAD_POOL)

Displays the largest number of threads since the server 
was most recently started.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads
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Core parameters
RejectedCount (PJB_threadsTHREAD_POOL)

Displays the number of rejected threads.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

PJB_QUEUELESS_THREAD_POOL application class

CurrentThreadCount 
(PJB_QUEUELESS_THREAD_POOL)

Displays the current number of threads.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

LargestThreadCount 
(PJB_QUEUELESS_THREAD_POOL)

Displays the largest number of threads since the server 
was most recently started.

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

RejectedCount (PJB_QUEUELESS_THREAD_POOL)

Displays the number of rejected threads since the 
server was most recently started

Collector: collectCategories
JBOSS version: 6.0

yes con undef undef undef graph number of 
threads

JB_REGISTERED_ENVIRONMENT application class 

collectCategories 
(PJB_REGISTERED_ENVIRONMENT)

Reads the discovered categories and values from the 
admin client

Collector: N/A 
JBOSS version: 4.0, 5.0, 6.0

yes collect
or

undef undef 10 sec undef undef
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Core parameters
PatrolCollectionStatus 
(PJB_REGISTERED_ENVIRONMENT)

Displays the status of PATROL collection

Collector: PatrolCollectionStatus 
JBOSS version: 4.0, 5.0, 6.0

yes stand
ard

1 undef 1 min State 
Boolea
n

0=OK
1= not OK

PJB_SERVER application class

ServerStatus (PJB_SERVER)

Displays the status of the server.

Collector: ServerStatus 
JBOSS version: 4.0, 5.0, 6.0

yes stand
ard

1 undef 1 min State 
Boolea
n

0=Running
1= Stopped

PJB_SERVLET application class
ClassLoadTime (PJB_SERVLET)

Displays the time required to load a class.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms 

ErrorCount (PJB_SERVLET)

Displays the number of servlet requests that 
encountered errors or exceptions during the collection 
interval.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph number of 
requests

LoadTime (PJB_SERVLET)

Displays the time required to load the servlet.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms

maxTime (PJB_SERVLET)

Displays the maximum processing time of a request.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms
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Core parameters
minTime (PJB_SERVLET)

Displays the minimum processing time of a request.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms

ProcessingTime (PJB_SERVLET)

Displays the time required to complete a servlet 
request during the collection interval.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms

RequestCount (PJB_SERVLET)

Displays the number of requests processed by the 
servlet during the collection interval.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms

PJB_WAR application class
CacheMaxSize (PJB_WAR)

Displays the maximum cache size in MB.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph Mbyte

ProcessingTime (PJB_WAR)

Displayes the cumulative execution times of all 
servlets in this context.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms
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Core parameters
StartupTime (PJB_WAR)

Displays the time in milliseconds taken to start this 
context.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms

UnloadDelay (PJB_WAR)

Displays the time duration in milliseconds that the 
container waits for servlets to unload.

Collector: collectCategories 
JBOSS version: 4.0, 5.0, 6.0

yes con undef undef undef graph ms

Table 7 PATROL for JBoss Application Server core parameters  (Part 20 of 20)

A
ct

iv
e?

 

Ty
pe

 

W
ar

ni
ng

(A
la

rm
1)

 

A
la

rm
(A

la
rm

2)
 

Sc
he

du
lin

g

Ic
on

 

U
ni

ts
 

Appendix B Parameter reference 85



Core parameters
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A p p e n d i x C

C  Menu summary

This chapter summarizes the application menus and menu commands for the 
PATROL for JBoss Application Server product. The following topics are discussed in 
this chapter:

Core product application class menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87
PJB_SETUP application menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87
PJB_ENVIRONMENT application menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  88

Core product application class menus
The menus explained in this section are associated with the application classes for the 
PATROL for JBoss Application Server product. Each of these classes begins with the 
designation PJB*.

PJB_SETUP application menu

The menu commands in Table 8 are the PATROL KM menu commands for the 
PJB_SETUP application class.

Table 8 PJB_SETUP commands

Menu command Action

Register New Environment Click to configure a new JBoss environment.
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Core product application class menus
PJB_ENVIRONMENT application menu

The menu commands in Table 9 are the PATROL KM menu commands for the 
PJB_ENVIRONMENT application class.

Table 9 PJB_ENVIRONMENT commands

Menu Command Action

Unregister Environment Click to unregister the JBoss environment.

Edit Environment Click to change the configuration of the JBoss environment.

Note: If you change the Host name, JMX port, or collection 
type, the existing JBoss environment configuration will be 
deleted. You cannot change the name of a JBoss 
Environment.

Select Collection Categories Click to set the data collection categories that you want to 
use for the JBoss environment. 

Toggle Java Debug Click to toggle Java debugging.

If Java debugging is currently disabled, selecting this option 
enables it. Alternately, if Java debugging is currently 
enabled, selecting this option disables it.

Toggle PSL Debug Click to toggle PSL debugging.

If PSL debugging is currently disabled, selecting this option 
enables it. Alternately, if PSL debugging is currently 
enabled, selecting this option disables it.
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A p p e n d i x D

D  Product InfoBoxes

This chapter summarizes InfoBoxes available in the PATROL for JBoss Application 
Server product. Some application classes may appear only if certain features are 
enabled in your environment or configured for your PATROL monitoring 
environment.

The following topics are discussed in this chapter:

Standard InfoBox fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89
Core product application class InfoBoxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

PJB_ENVIRONMENT InfoBox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Standard InfoBox fields
Table 10 lists the fields that are standard for all application class InfoBoxes in the 
PATROL for JBoss Application Server product. All other InfoBox fields explained in 
this chapter appear in addition to these standard fields.

Table 10 PATROL for JBoss Application Server standard InfoBox fields

Item Description

History Retention number of days for which a current history has been kept

Worst Parameter name of the parameter with the worst performance in the 
application class

Default username account name used if not otherwise specified

Application class name of the application class (PATROL application class, not 
Java application class)

State current state of the application, such as “OK,” “running,” or 
“stopped”

Icon type icon type—for application class InfoBoxes, this will be 
“Application”
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Core product application class InfoBoxes
Core product application class InfoBoxes
The application class InfoBoxes explained in this section are part of the core PATROL 
for JBoss Application Server product. Each of these application classes begins with 
PJB_*.

PJB_ENVIRONMENT InfoBox

Table 11 lists the items beyond standard InfoBox items for the PJB_ENVIRONMENT 
application class. 

Table 11 PJB_ENVIRONMENT application class InfoBox items 

Item Description

KM Version displays the version number of the KM.

Host Name displays the Host Name of the JBoss Application Server that 
you want to monitor.

JMX Port displays the JMX Port that the KM uses to connect to the 
JBoss Application Server.

User Name displays the JBoss Application Server account user name.

Admin Client PID displays the Java admin client process ID.
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A p p e n d i x E

E  Agent configuration variables

The variables described in this section are PATROL for JBoss Application Server 
variables that are set in the PATROL Agent. You can use the PATROL Configuration 
Manager or the wpconfig utility to view variable settings or to deploy them to others 
machines. See the PATROL Configuration Manager User Guide or the PATROL Agent 
Reference Manual for more information.

WARNING  
Changing any of these variables may prevent some functions from working properly, 
and may affect your entire installation. Make a record of the original setting for a 
variable before you change it. 

WARNING  
Many PATROL for JBoss Application Server variables are set by menu commands or 
functions. Do not use the wpconfig utility or PATROL Configuration Manager to 
remove variables or add new variables. Doing so may prevent some functions from 
working properly and can affect your entire installation. BMC Software recommends 
that you set agent configuration variables by using a console to configure PATROL 
for JBoss Application Server. 

NOTE  
Some of the variables described in this appendix may not appear in your 
environment. Some variables exist only when their corresponding features are 
enabled or when non-default performance options are selected. 

Table 12 Agent variables used by PATROL for JBoss Application Server  (Part 1 of 3)

Variable Description Location

Agent variables located in /JBossSetup/Defaults

JAVA_HOME specifies the path to the default Java 
Home directory.

/JBossSetup/Defaults/JAVA_HOME
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javaLogFilePath specifies the default path for Java 
debugging.

/JBossSetup/Defaults/javaLogFilePath

JBOSS_HOME provides the path to the default 
JBoss Home directory.

/JBossSetup/Defaults/JBOSS_HOME

logFileName specifies the full path with file 
name for PSL debugging.

/JBossSetup/Defaults/logFileName

OSusername specifies the default operating 
system account user name.

/JBossSetup/Defaults/OSusername

Agent variables located in /JBossSetup/Environments

adminPassword contains the JBoss Application 
Server admin account password for 
the environment.

/JBossSetup/Environments/<EnvName>
/adminPassword

adminUsername contains the JBoss Application 
Server admin account user name 
for the environment.

/JBossSetup/Environments/<EnvName>
/adminUsername

doDiscovery discovers categories. /JBossSetup/Environments/<EnvName>
/doDiscovery

doEdit saves the changes that you make in 
the environment settings.

/JBossSetup/Environments/<EnvName>
/doEdit

EnvType specifies the type of environment. /JBossSetup/Environments/<EnvName>
/EnvType

Hostname contains the JBoss server host name 
specified in the environment.

/JBossSetup/Environments/<EnvName>
/Hostname

JAVA_HOME contains the path to the Java Home 
directory specified in the 
environment.

/JBossSetup/Environments/<EnvName>
/JAVA_HOME

javaLogFilePath contains the default path for Java 
debugging for the environment.

/JBossSetup/Environments/<EnvName>
/javaLogFilePath

JBOSS_HOME contains the path to the JBoss Home 
directory specified in the 
environment.

/JBossSetup/Environments/<EnvName>
/JBOSS_HOME

jmxPort contains the JMX port number for 
the environmen.

/JBossSetup/Environments/<EnvName>
/jmxPort

OSpassword contains the operating system user 
account password specified in the 
environment.

/JBossSetup/Environments/<EnvName>
/OSpassword

OSusername contains the operating system user 
name specified in the environment.

/JBossSetup/Environments/<EnvName>
/OSusername

PJB_EJB discovers the EJB category for the 
environment.

/JBossSetup/Environments/<EnvName>
/PJB_EJB

Table 12 Agent variables used by PATROL for JBoss Application Server  (Part 2 of 3)

Variable Description Location
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PJB_JCA discovers the JCA category for the 
environment.

/JBossSetup/Environments/<EnvName>
/PJB_JCA

PJB_JMS discovers the JMS category for the 
environment.

/JBossSetup/Environments/<EnvName>
/PJB_JMS

PJB_JTA discovers the JTA category for the 
environment.

/JBossSetup/Environments/<EnvName>
/PJB_JTA

PJB_JVM discovers the JVM category for the 
environment.

/JBossSetup/Environments/<EnvName>
/PJB_JVM

PJB_SERVLET discovers the SERVLET category 
for the environment.

/JBossSetup/Environments/<EnvName>
/PJB_SERVLET

PJB_THREAD discovers the THREAD category for 
the environment.

/JBossSetup/Environments/<EnvName>
/PJB_THREAD

PJB_WAR discovers the WAR category for the 
environment.

/JBossSetup/Environments/<EnvName>
/PJB_WAR

Table 12 Agent variables used by PATROL for JBoss Application Server  (Part 3 of 3)

Variable Description Location
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